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AUTOCAD SCREEN 
The autocad interface consists of several different screen elements most of which you can 
customize. 
 

 
 
 
 
 
 
The drawing area: 
The main blank area in the middle of the screen is where you draw.You can compare this space 
to a piesce of drafting paper except for that this space can be of any size….even the size of a 
factory!. 
To specify a point it is convectional to put the x cor-ordinate first then a comma and then the y 
cordinate 
 
The ucs icon 
This is the symbol  with two arrows at the bottom left corner of the drawing area. This symbol is 
called the ucs (User Cordinate Sytem). The arrow points to the Positive x and y directions. 
 
The crosshairs 
When you move your mouse across the drawing space you note that t5here are two intersecting 
lines with a small box at their intersection. The small box is calleed the pickbox as it khelps in 
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picking objects. The lines are called crosshairs as they help you in judging the location of the 
mouse pointer on the screen in relation to other opbjects. 
 
The menus and toolbars 
At the top of your screen is the tittle bar and directly beneath the tittle bar is the menu bar. The 
menus and toolbars together allow you to give autocad commands to draw, edit,get information, 
and so on. You can customize the menus and toolbars to suit your needsso that your screen may 
appear somewhat differently.there are many more toolbars that you may display when you need 
them. Some of these toolbars are dimensioning,solids,render etc 
 
The command line 
At the bottom of the screen you see aseparate window showing approximately three lines of 
text(it can be changed to show as many lines as you like) 
Notice the word command. This is the command line and its where all commands can be 
executed when typed in here. 
 
The status bar. 
At the verry bottom of the screen is the status bar. At the left are the x,y cordinates.as you move 
your mouse around they change accordingly. 
 
Opening autocad and starting a drawing. 
You start autocad by clicking the start button then programms then autocad r13. 
Once you do this autocad starts and prompts you with the following screen: 

 
 
 
 
Type in the new drawing name you are creating in the text box and click ok. 
Autocad creates anew drawing with this name you provided. 
Now use the line command  to draw lines anyhowly on the screen. 
 
 
 
 
Once you finish it is time to save your drawing. 
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Saving your drawing 
Saving a drawing in autocad is similar to saving a file like  in any other application. You should 
get into the habbit of saving your work in every 10 to 15 minutes interval to avoid losing your 
drawings.  
To save your work go to File Save and the file will be updated if you had given it a name 
initially. If you had not a dialog box will appear in which you may type the name you want to 
give your file . 

   
 
Opening a drawing 
AutoCad  offers a number of 
options for opening a drawing. 
When you are creating a new  
drawing you may choose to use 
a template. A template is a 
drawing with some ready made 
settings. These settings may 
include  the size of the drawing 
(limits), the unit type ,tittle 
blocks,standardized texts etc. 
 
 
 
 
 
Exiting a drawing 
You can open only one drawing at a time,thus you can never exit  a drawing while still 
remaining in AutoCad. Instead you can either exit AutoCad entirely or open a new or existing 
drawing without exiting AutoCad. 
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BASIC COMMANDS. 
 
In Autocad you can issue commands by :- 

• Choosing a tool from a toolbar. 
• Choosing a command from the menu. 
• Typing a command at the command line. 

In this course we will use all the three  ways where convenient. 
 
Responding to  command options 
 
Many commands have a number of options from which you need to choose . 
To choose an option on the command line type the letter that is capitalized in the opyion name 
usually the first letter of the option (But not always) and then press  ↵ 
 
To choose a default option on the command line which appears  in the angled brackets simply 
press the ENTER . 
At this point additional options may appear or you may be prompted to select a point or an 
object. 
 
DRAWING A LINE 
Drawing a line using absolute coordinates 
 
1 From the Draw toolbar, choose the Line flyout, then . 
2 Enter the X and Y values of the coordinate separated by a comma (no spaces) as in the 

following example: 1,3 
3 Enter a different set of X and Y values, as in the following example: 2,2 
 
AutoCAD draws a line segment between the two points. 
 
3 Enter a distance, a < sign, and an angle, as in the following example: . 
4 25<45 
 
AutoCAD continues the line with a second segment at the angle and distance you specified. 
 
Drawing a line using relative coordinates 
 
1 From the Draw toolbar, choose the Line flyout, then . 
2 Specify a start point (From point). 
3 Enter the X and Y values of the coordinate separated by a comma (no spaces), and 

precede the X value with an at sign (@), as in the following example: @3,5 
 
You can also draw a line by specifying a distance and an angle, as follows: 
 
1 From the Draw toolbar, choose the Line flyout, then . 
1 Specify a start point (From point). 
2 Enter an at sign (@), a distance, a less-than sign (<), and an angle as in the following 

example: @2<45 
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Drawing a line using an object snap mode 
 
1 Draw a line and a rectangle. 
2 From the Draw toolbar, choose the Line flyout, then . 
3 From the Options menu, choose Running Object Snap. 
4 In the Running Object Snap dialog box, choose Endpoint and press enter key . 
5 Click near the end of the line. 
6 From the Options menu, choose Running Object Snap. 
7 From the Running Object Snap dialog box, choose Intersection and press enter key . 
8 Click on the nearest corner of the rectangle. 
 
Drawing a line using Direct Distance Entry 
 
1 From the Draw toolbar, choose the Line flyout, then . 
2 Enter 2,2. 
3 Move your cursor any distance at a 45-degree angle. 
 
4 Enter 3. 
 
You should see a line 3-units long at a 45-degree angle, originating at 2,2. 
 
Drawing a circle 
1 From the Draw toolbar, choose the Circle flyout, then choose  
2 Use your pointing device or enter X and Y values to specify a center point for the circle. 
3 Specify a second point, enter a radius value type D  for Diameter entry value  and press 

enter key . 
 
Drawing a rectangle 
1 From the command line type Rectang  
2 Use your pointing device or enter X and Y values to specify a center point for the circle. 
3 Specify a second point and press enter key . Arectangle with the two points as the corners 

of the rectangle is automatically drawn . 
 
Drawing a Polygon 
1 From the command line type POLYGON  
2 Specify the number of sides that you require  
3 Use your pointing device or enter X and Y values to specify a center point for the 

polygon. 
4 Specify whether you want your polygon inscribed or circumscribed about a circle. 
5 Use your pointing device to specify a second point  or type the rdius of the circle and 

press enter key .  
 
Drawing an arc 
1. From the command line type arc 
2. Use your pointing device or enter X and Y values to specify a start  point for the arc 
3. . Use your pointing device or enter X and Y values to specify a second  point for the arc 
4. Use your pointing device or enter X and Y values to specify an end point for the arc 

An arc with the specified specifications is drawn. 
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Drawing an ellipse 
1. From the command line type ellipse 
2. Use your pointing device or enter X and Y values to specify the first axis endpoint.↵ 
3. Use your pointing device or enter X and Y values to specify a second  point for the second 

axis endpoint↵ 
4. Adjust your pointing device to get the ellipse you want. 
5. An ellipse with the specified specifications is drawn. 
 
Creating a point object 
 
1. From the Draw toolbar, choose the Point flyout, then ↵ 
2. At the Command prompt, enter point then↵ 
3. Point: Specify a point 

 Points can act as nodes to which you can snap objects. The current elevation is assumed if 
you omit the Z coordinate. 

 
Repeating commands 
The most common way to repeat a command is to press ENTER at the Command Prompt. The 
last command appears again. Clicking the right Mouse Button has the same effect as pressing the 
ENTER key. 
 
If you know in advance that you will be using a command several times then you may use 
another technique-Type  Multiple  a space then the command  name. The command 
automatically reappears on the command line untill you press escape key.  
 
Cancelling  commands 
 
As in any windows program when you press Esc the current command is canceled. In some 
instances you may need to press the Esc key twice. 
 
Undoing a command. 
Most windows applications offer the Undo and Redo commands. AutoCAD is no different . 
AutoCAD remembers every command you enter since the drawing was opened. Thus you can 
undo and redo actions on your drawings. 
 
However there are some actions that you may not be in a position to undo. Examples are 
Printing,saving.You cant unprint or unsave. 
 
The U command 
Each time you click undo on the standard toolbar AutoCAD  undoes one command. If you undo 
all the commands  you get the message “Everything has been undone” 
 
 The UNDO command 
The Undo command is more complex and offers several options. It can only be typed at the 
command line. The several options involved are Auto/Control/BEgin/End/Mark/<Number>:  
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Redoing a command. 
The Redo command has the effect of redoing the last U or UNDO  command. It only works on 
one command thus you can only use it once.  
Nb. It must be used immediately after the U or UNDO command 
 
The OOPS command 
 
The OOPS  command undoes the most recent command that erased an object even if  you have 
used  other commands in the meantime. This command brings back the object on the screen. 
 
Transparent commands         
Certain commands can be used within other Commands. These type of commands  are called 
transparent Commands. Once the transparent Command  is complete the original Command 
continues its regular operation. 
 
 
THE COORDINATES SYSTEM 
   Secifying coordinates on the screen is one of the most fundamental tasks in autocad.Unless you 
know how to specify  a point you cant draw anything real. 
 
Every  point on your screen is defined  in terms of X and Y coordinates. 
 
Absolute cartesian coordinates 
When you type aline and enter the actual coordinates  such as line from point 3,2 to 5,8  you are 
using absolute cartesian coordinates. Absolute coordinates are measured from 0,0. 
 
Relative cartesian coordinates 
Relative coordinates specify the X and the Y distance from the previous point. They are called 
relative coordinates because they have meaning relative to a point previously defined. 
You tell AutoCAD that the coordinates are relative by using the @symbol 
 
Polar Coordinates: 
Another  common situation is to know the distance and angle  of a point from either 0,0 or a 
previous point. In this case you can use the polar coordinates, which can be either absolute or 
relative. 
Polar Coordinate take the form of  distance<angle. 
 
Object Snap settings 
The SNAP command is an alternative to tediuos entry of coordinates. 
Often you need to draw objects relative to the  previously drawn objects. AutoCAD offers 
OSNAP (Object snap) that allows you to specify a point  by snapping to a geometrically defined 
point on an existing object. 
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Snapping specific points on an object 
 
Snapping to an endpoint 
 
1 Draw a rectangle. 
2 From the Draw toolbar, choose the Line flyout, then . 
3 Specify the start point (From point) of the line. 
4 From the Options menu, choose Running Object Snap. 
5 In the Running Object Snap dialog box, choose Endpoint and press enter key . 
6 Select the side of the rectangle closest to the cursor and press enter key . 
 
Snapping to a midpoint 
 
1 Draw a rectangle. 
2 From the Draw toolbar, choose the Line flyout, then . 
 
3 Specify the start point (From point) of the line. 
4 From the Options menu, choose Running Object Snap. 
5 In the Running Object Snap dialog box, choose Midpoint and press enter key . 
6 Select the side of the rectangle closest to the cursor and press .ENTER KEY  
 
Snapping to the center point of a circle 
 
1 Draw a circle. 
2 From the Draw toolbar, choose the Line flyout, then . 
3 Specify the start point (From point) of the line. 
4 From the Options menu, choose Running Object Snap. 
5 In the Running Object Snap dialog box, choose Center and press enter key . 
6 Select the circle and press enter key . 
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Snapping to a node 
 
1 Draw a point using the POINT command. 
2 From the Draw toolbar, choose the Line flyout, then . 
3 Specify the start point (From point) of the line. 
4 From the Options menu, choose Running Object Snap. 
5 In the Running Object Snap dialog box, choose Node and press enter key . 
6 Select the point and press enter key . 
 
Snapping to a quadrant 
 
1 Draw a circle. 
2 From the Draw toolbar, choose the Line flyout, then . 
3 Specify the start point (From point) of the line. 
4 From the Options menu, choose Running Object Snap. 
5 In the Running Object Snap dialog box, choose Quadrant and press enter key . 
6 Select the circle and press enter key . 
 
AutoCAD snaps to the closest 0-, 90-, 180-, or 270-degree point on the circle. 
 
Snapping to the intersection of two objects 
 
1 Draw two lines that intersect. 
2 From the Draw toolbar, choose the Line flyout, then . 
3 Specify the start point (From point) of the line. 
4 From the Options menu, choose Running Object Snap. 
1 In the Running Object Snap dialog box, choose Intersection and press .ENTER KEY  
6 Select a point near the intersection of the two lines and press .ENTER KEY  
 
 
 
Snapping to a perpendicular point 
 
1 Draw a rectangle. 
2 From the Draw toolbar, choose the Line flyout, then . 
3 Specify the start point (From point) of the line. 
4 From the Options menu, choose Running Object Snap. 
5 In the Running Object Snap dialog box, choose Perpendicular and press enter key . 
6 Select the rectangle and press enter key . 
 
Snapping to a tangent point 
 
1 Draw a circle. 
2 From the Draw toolbar, choose the Line flyout, then . 
3 Specify the start point (From point) of the line. 
4 From the Options menu, choose Running Object Snap. 
5 In the Running Object Snap dialog box, choose Tangent and press enter key . 
6 Select the circle and press enter key . 
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Snapping to the nearest point 
 
1 Draw a rectangle. 
2 From the Draw toolbar, choose the Line flyout, then . 
3 Specify the start point (From point) of the line. 
4 From the Options menu, choose Running Object Snap. 
5 In the Running Object Snap dialog box, choose Nearest and press enter key . 
6 Select the rectangle and press enter key . 
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EDITING DRAWINGS 
 
Copying commands. 
Four commands allows you to copy objects in  verry specific ways. These are mainly the  
Mirror,Array,Copy and Offset commands. 
 
Mirror Command 
Many drawings have symmetrical elements. Often in mechanical drawings you can create one-
half or one-quarter of an object and complete it with  simply by mirroring what you have drawn. 
To mirror  select an object and then choose mirror from the modify toolbar (or typr mirror at the 
prompt) Choose two points that will be used as mirror line. 
 
Making a mirror image of an object 
 
1 From the Draw toolbar, choose the Line flyout, then . 
2 Draw a triangle. 
3 From the Modify toolbar, choose the Copy flyout, then . 
4 Select each side of the triangle and press enter key . 
5 Specify the first point of the mirror line. 
6 Specify the second point of the mirror line. 
7 Press enter key  to retain the original triangle. 
 
Array command 
 The array command creates a rectangular or circular pattern by copying the object(s) you select 
as many times as you specify. 
To create an array select the object or objects and choose array from the modify toolbar. 
 
Rectangular arrays 
These are arrays that are produced in rows and collumns. Thus in rectangular arrays you must 
specify the number of collumns and rows that you need. 
 
 
Creating a rectangular array 
 
1 From the Modify toolbar, choose the Copy flyout, then . 
2 Select an object to copy and press enter key . 
3 Enter the number of rows. 
4 Enter the number of 
columns. 
5 Enter the distance between 
rows. 
6 Enter the distance between 
columns. 
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Polar (circular) arrays 
These are arrays that are produced round in a circular form. Thus in polar arrays you must 
specify the number of objects and the angle through which you need them spread over. 
 
 
 
 
 
 
 
 
 
 
Creating a polar array 
 
1 From the Modify toolbar, choose the Copy flyout, then . 
2 Select an object to copy and press enter key . 
3 Specify the center point of the array. 
4 Enter the number of items. 
5 Enter the angle that you want the array to fill. 
6 Press enter key  to rotate the objects or enter N not to rotate them. 
 
Offset command 
OFFSET creates a new object at a specified distance from an existing object or through a 
specified point. 
Type the command offset  command  
When you specify a distance, offset Creates an object at a specified distance from an existing 
object.  
When you choose through, offset Creates an object through the point you have specified. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Produced by 
polar array 

Original 
object drawn 

Offset 
distance 

Object to 
be offset 

Result of 
Offset  

Before the 
offset  

After the 
offset  



 

 17

Copy command 
The copy command duplicates a drawing. 
Type the command copy  then select an object you want to copy.  
 
Copying an object to use again in your drawing 
 
1 From the Modify toolbar, choose the Copy flyout, then . 
2 Select an object and press enter key . 
3 Specify the base point on the object. 
 

AutoCAD copies the selected object but does not place it in your drawing until you 
specify a second point of displacement. 

 
4 Drag your cursor across the screen. 

AutoCAD copies the object and draws a rubber-band line from the specified base point to 
the cursor. 

 
5 Drag the copied object to the Second point of displacement and click the left pointing 

device button. 
 
 
Trimming objects 
As you edit your drawing you may realise that the lines that used to meet perfectly now hang 
over. In this case you need to trim such objects. To trim an object you must first specify  the 
cutting edge. When you select an object to trim you must select the object that that you want 
trimmed. 
 
 
 
 
 
 
 
 
 
 
 
Trimming an object 
 
2 From the Modify toolbar, choose Trim flyout, then . 
3 Select an arc, circle, line, or open 2D or 3D polyline that intersects the object to trim. 
3 Press .ENTER KEY  
4 Select the object to trim. 
5 Press .ENTER KEY  
 
AutoCAD trims the second object, using the first object as the cutting edge. 
 
 
 

Objects before 
the trim effect 

Objects after the 
trim effect 
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Erasing an object 
The Erase command Removes objects from a drawing 
From the Modify menu choose Erase, while At the Command prompt, enter erase 
Select objects: Use an object selection method to select the objects you want to erase. 
AutoCAD removes the objects from the drawing. 
 
Moving an object 
 
Now and then you will be required to move objects from one position to another in your 
drawing. Basically the command move Displaces objects a specified distance in a specified 
direction in your drawing. 
 
To move an object  
At the Command prompt, enter move 
Select objects: Use an object selection method to select the objects you want to move 
Base point or displacement: Specify a base point. 
Second point of displacement: Specify a second point or press  
      
The two points you specify define a displacement vector that indicates how far the selected 
objects are to be moved and in what direction. If you press enter   at the second point, the first 
point is interpreted as relative X,Y,Z displacement. 
 
Rotating an object 
You may require to rotate your objects to suit your needs.the command rotate Moves objects 
about a base point. To rotate an object about a point  
 
At the Command prompt, enter rotate 
Select objects: Use an object selection method to select athe object you want rotated. 
Base point: Specify a point  
<Rotation angle> / Reference: Specify an angle for rotation. 
 
Chamfer 
  The chamfer command creates corners from two nonparrallel lines. Chamfering is a two step 
process. First you define how you  want to chamfer the corner after which the command ends. To 
actually chamfer you need to start the chamfer command again . AutoCAD chamfers them using 
the information you previously specified.   
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Fillet 
The FILLET command rounds or fillets the edges of two arcs, circles, elliptical arcs, lines, 
polylines, rays, splines, or xlines with an arc of a specified radius. If the selected lines do not 
intersect, AutoCAD extends or trims them so that they do. FILLET also rounds or fillets the 
edges of solids. If both objects to be filleted are on the same layer, AutoCAD creates the fillet 
line on that layer. Otherwise, AutoCAD creates the fillet line on the current layer. This is also 
true for the fillet color and linetype. 
You cannot fillet line segments that intersect outside the drawing limits when limits checking is 
on.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To fillet: 
At the Command prompt, enter fillet 
Polyline / Radius / Trim / <Select first object>: Use an object selection method or enter an option 
 
Select first object: 
Select second object: Use an object selection method to select the second object. 
 
If you select lines or arcs, AutoCAD extends these lines or arcs until they intersect, or trims them 
at the intersection, keeping the selected segments if they cross. You can fillet two lines with 
different extrusion directions only if the Z values of the endpoints of both lines are equal in the 
current UCS. 
 
Dividing objects 
The  Divide command Places evenly spaced point objects or blocks along the length or perimeter 
of an object 
 
To divide an object: 
 
At the Command prompt, enter divide 
Select object to divide: Use an object selection method  
<Number of segments> / Block: Enter a value (between2 and 32767). 
 
For a closed polyline, the first dividing point is at its initial vertex and there are the same number 
of segments and dividing points. For an open polyline, the first dividing point is after the first 

Object before 
Filleting 

Filleted Object 

Filleted Object 
with radius 6 
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segment along the polyline and there is one more segment than there are dividing points. For a 
circle, the first dividing point is normally just right of its center, on its circumference.  
The point objects or blocks are placed in the Previous selection set. To select them all, enter p at 
the next Select objects prompt. 
 
Scaling objects 
The Scale command Enlarges or reduces selected objects equally in the X, Y, and Z directions 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To scale an object: 
At the Command prompt, enter scale 
Select objects: Use an object selection method to select an object to scale 
Base point: Specify a point  
<Scale factor> Multiplies the dimensions of the selected objects by the specified scale. A scale 
factor greater than 1 enlarges the objects. A scale factor between 0 and 1 shrinks the objects. 
 
Using Grips: 
Grips offer a whole new way to edit objects without choosing commands. By using grips you can 
quickly stretch, move,rotate,scale and mirror objects. 
When you select an object without first choosing a command the object appears highlighted with 
grips. 
 
 
 
 
 
 
 

Object after 
scaling with 
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1 

Object to be 
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Object after 
scaling with 
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Grips 
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Viewing  drawings 
 
Regen 
REGEN regenerates the entire drawing and recomputes the screen coordinates for all objects. It 
also reindexes the drawing database for optimum display and object selection performance. 
At the Command prompt, enter regen AutoCAD regenerates the current view and it also removes 
blip marks 
 
Redraw  
This command Refreshes the display of the current viewport removes marker blips and display 
artifacts (stray pixels) left by editing commands. 
 
To remove marker blips: 
At the Command prompt, enter redraw 
AutoCAD redraws the current viewport drawing. 
 
Pan 
This command Moves the drawing display in the current viewport 
 
PAN works in two ways. You can specify a single point, indicating the relative displacement of 
the drawing with respect to the screen, or (more commonly) you can specify two points, in which 
case AutoCAD computes the displacement from the first point to the second point. You can use 
PAN transparently but you cant use it  transparently while in paper space 
 
To pan:   
At the Command prompt, enter pan 
Displacement: Specify a point . 
The point you specify indicates the amount to move the drawing or the location of the drawing to 
be moved. 
Second point: Press  Enter or specify a second point. If you press  enter, AutoCAD moves the 
drawing by the amount you specified in the Displacement prompt. If you specify a second point, 
AutoCAD moves the location of the drawing to that point. 
 
Zoom 
The Zoom command Increases or decreases the apparent size of objects in the current viewport 
You can use ZOOM transparently. You can't use ZOOM transparently while in paper space or 
while another ZOOM, PAN, or VIEW command is in progress. 
 
To zoom: 
At the Command prompt, enter zoom 
All / Center / Dynamic / Extents / Left  / Previous / Vmax / Window / <Scale(X/XP)>: Enter an 
option or value, specify a point, or press enter  
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Named  views: 
 
After  you have done a lot of panning and zooming in a drawing  you may find that you return to 
the same part of your drawing again and again. In alarge drawing it may take quite some time to 
display the part of the drawing that you want. 
 
A view is simply a display of a drawing on your screen. It can show any part of your drawing at 
any magnification. Once you have the display you  give the view a name and save it. 
 
Tiled ViewPorts   
 
Tiled viewports lets you divide up the screen into rectangular bounding boxes. You can then 
show a different view of your drawing in each viewport. The purpose of the viewports is yo 
make it easier to draw. 
 
 
 

 
 Four tiled ViewPorts representing a single object. 
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ORGANIZING DRAWINGS 
 
Working with Layers  
The best way to organize your drawing into colors and linetypes is to use layers. Layers offer 
powerful features that enable you to  distinguish all the various elements  of your drawing. 
Creating layers is an important  part in setting  up a drawing. Layers  can be craeted and saved  in 
your templates (Prototype drawings). Layers give you  many ways to organize your drawing. 
 
• You can assign  different colors and linetypes  to layers. 
• You can assign the various colors to different  pens in a plotter, resulting in a drawing with 

varying colors or line widths. 
• You can control which objects are plotted. 
• You can lock a layer so that objects in that layer can not be edited. 
 
The command LAYER creates new layers, selects the current layer, sets the color and linetype 
for designated layers, turns layers on and off, locks or unlocks layers, freezes or thaws layers, 
and lists defined layers.  
 

 
 
To use layers: At the Command prompt, enter layer 
The following prompts appears: 
? / Make / Set / New  / On  / OFF / Color / Ltype / Freeze / Thaw / LOck / Unlock:  
Enter an option you require.  
The  above options have the following meanings. 
 
? -- List Layers  Displays a list of the currently defined layers, showing 

their names, states, color numbers, linetypes, and any 
externally dependent layers. 
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Layer name(s) to list <*>: Enter a name list or press  enter 
 
Make  Creates a layer and makes it current. New objects are 

placed on the current layer as they are drawn. 
  
 New current layer <current>: Enter a name or press enter 
 

If no layer exists for the name you enter, AutoCAD creates 
a new layer by that name. That layer is turned on and is 
assigned color number 7 and the CONTINUOUS linetype. 
If the layer exists but is turned off, AutoCAD turns it on. 

 
Set Specifies a new current layer but does not create the layer if 

it doesn't already exist. If the layer exists but it is turned 
off, the Set option turns it on and makes it current. 

 
New current layer <current>: Enter a name 

 
 
 
 
New  Creates one or more layers. You can create two or more 

layers by entering two or more names, separated by 
commas. 
New layer name(s): Enter a name list 

 
On/off     Turns on/off  layers. 
 
Color     Changes the color associated with a layer. 
     Color: Enter a color name or color number 1-255 

AutoCAD prompts for a list of layer names to which the 
color should be applied.  
The layers are turned on. To assign a color but turn off the 
layer, precede the color with a minus sign (-). 

 
Ltype      Changes the linetype associated with a layer. 

Linetype (or ?) <CONTINUOUS>: Enter a currently 
loaded linetype name, enter ?, or press  enter 
If you enter a linetype name or press , AutoCAD prompts 
for a list of layer names to which the linetype should be 
applied. 
Layer name(s) for linetype xxx <current>: Enter a name list 
or press enter 
If you enter ? at the Linetype (or ?) prompt, AutoCAD 
prompts for the linetypes to list. 
Linetype(s) to list <*>: Enter a name list or press  

 
Freeze  Freezes layers, making them invisible and excluding them 

from regeneration and plotting. 
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Layer name(s) to Freeze: Enter a name list  
 
Thaw      Thaws frozen layers.  

Layer name(s) to Thaw: Enter a name list  
 
Lock     Locks layers, preventing editing on those layers. 

Layer name(s) to Lock: Enter a name list  
 
Unlock  Unlocks selected locked layers, permitting editing on those 

layers. Layer name(s) to Unlock: Enter a name list  
 
Working with color 
 
CHANGING COLOR 
You can change the color of an existing object(s). You can also change the current color. When 
you change the current color all future objects you draw have that color and are not drawn 
according to their layers assigned color. 
 
 

 
 
The command color Sets the color for new objects. 
To set the color: 
 
At the Command prompt, enter color 
New object color <current>: Enter a value (1-255), color name, byblock, or bylayer 
Enter the color number in the range from 1 to 255 or enter a standard color name. The standard 
color names are red, yellow, green, cyan, blue, magenta, black, and white. If you enter byblock, 
AutoCAD draws new objects in the default color (white or black, depending on your 
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configuration) until they are grouped into a block. When the block is inserted in the drawing, the 
objects in the block inherit the current setting of the COLOR command. 
Warning: If you used a mixture of color methods to draw the objects that make up a block, 
inserting that block or changing its color produces unpredictable results.If you enter bylayer, new 
objects assume the color of the layer upon which they are drawn. See the LAYER command for 
information on assigning a color to a layer. 
 
Changing Linetypes 
You can change the linetype of an existing object(s). You can also change the current linetype. 
When you change the current linetype all future objects you draw have that linetype and are not 
drawn according to their layers assigned linetype. 
You can control an objects linetype using the linetype control drop down list on the  object 
properties toolbar. The BYLAYER linetype simply means that the linetype of the object  is taken 
from the linetype of the objects layer. 
 
To change linetypes use the command Linetype which creates, loads, and sets linetypes The 
LINETYPE command defines line characteristics consisting of combinations of dashes, dots, and 
spaces. LINETYPE can either load linetype definitions from a library file or add new definitions 
to a library file. 
 
 
 
At the Command prompt, enter linetype 
? / Create / Load / Set: Enter an option. 
 
Available Options  
?  Lists Linetypes . 
 
The ? option Lists the linetypes available in a file. 
 
File to list <current>: Enter a linetype file name or press  enter. 
 
 
 
 
Create  
This option Creates a new linetype and stores it in a library (.lin) file. 
 
Name of linetype to create: Enter a name 
AutoCAD displays the Create or Append Linetype File dialog box. Specify the file to which you 
want the linetype added. 
 
Descriptive text: Enter optional descriptive text 
Enter a linetype description up to 47 characters long. The description can be a comment or a 
series of underscores, dots, dashes, and spaces to show a simple representation of the linetype 
pattern. 
 
Enter pattern (on next line) 
A, Enter pattern definition 
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Enter a series of numbers separated by commas. Enter positive values to specify lengths of 
dashes and negative values to specify lengths of spaces. Use a zero to represent a dot. 
The "A" in the pattern definition prompt specifies the pattern alignment used at the ends of 
individual lines, circles, and arcs. AutoCAD supports A-type alignment only. With A-type 
alignment, AutoCAD guarantees that lines and arcs start and end with a dash. The A is 
automatically included in the definition. If you use a text editor to create a linetype, you must 
enter a at the beginning of the definition. After creating a linetype, you must load it to make it 
accessible. You cannot create complex linetypes with the linetype command.  
 
Load  
This option Loads a linetype whose definition exists in a file. The acad.lin file contains the 
standard linetypes. 
Linetype(s) to load: Enter a name list 
AutoCAD displays the  Select Linetype File dialog box. Enter or select the file name in which 
the linetype is stored. 
 
Set  
Sets the current linetype for subsequently drawn objects. You can control the linetype of objects 
individually or by layer. 
 
New object linetype (or ?) <current>: Enter a linetype name, ?, bylayer, or byblock, or press  
The linetype you enter becomes the current linetype. AutoCAD draws all new objects with this 
linetype, regardless of the current layer. If the linetype you request isn't loaded, AutoCAD 
searches for its definition in acad.lin. If the linetype is neither loaded nor in acad.lin, AutoCAD 
reports this deficiency and returns to the main Command prompt. Enter ? to list all loaded 
linetype names. If you enter bylayer, new objects inherit the linetype associated with the layer on 
which the object is drawn. If you enter byblock, new objects are drawn using the 
CONTINUOUS linetype until they are grouped into a block. Whenever you insert that block, the 
objects inherit the linetype of the block. 
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GETTING INFORMATION FROM YOUR DRAWING 
CALCULATIONS 
Autocads standard calculator  CAL 
The command Cal Evaluates mathematical and geometric expressions. 
 
To perfom mathematical calculations: 
At the Command prompt, enter cal 
CAL is an on-line geometry calculator that evaluates point (vector), real, or integer expressions. 
The expressions can access existing geometry using the object snap functions such as CEN, 
END, and INS. You can insert AutoLISP variables into the arithmetic expression, and assign the 
value of the expression back to an AutoLISP variable. You can use these arithmetic and vector 
expressions in any AutoCAD command that expects points, vectors, or numbers. 
 
Standard Numeric Functions  
CAL supports these standard numeric functions:  
 
Function Description 
sin(angle) Sine of the angle  
cos(angle) Cosine of the angle 
tang(angle
) 

Tangent of the angle 

asin(real) Arcsine of the number. The number must be between -1 and 
1 

acos(real) Arccosine of the number. The number must be between -1 
and 1 

atan(real)  Arctangent of the number 
ln(real) Natural log of the number 
log(real) Base-10 log of the number  
exp(real) Natural exponent of the number  
exp10(real
) 

Base-10 exponent of the number  

sqr(real) Square of a number  
sqrt(real) Square root of a number. The number must be non-negative 
abs(real) Absolute value of the number 
round(real
) 

Number rounded to the nearest integer  

trunc(real) Integer portion of the number  
r2d(angle) Angles in radians converted to degrees. For example, r2d(pi) 

converts the constant pi to 180 degrees 
d2r(angle) Angles in degrees converted to radians. For example, d2r 

(180) converts 180 degrees to radians and returns the value 
of the constant pi 

pi  The constant pi  
Calculating distances(Cal) 
Autocad  makes it easy to calculate the distances between two points. The command  
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dist(p1,p2) Determines the distance between two points p1 and p2. This is the same as the 
vector expression abs(p1 - p2). 
dpl(p,p1,p2) Determines the shortest distance between point p and the line passing through 
points p1 and p2. 
dpp(p,p1,p2,p3) Determines the distance from a point p to a plane defined by three points 
(p1,p2,p3). 
The following example returns half the distance between the centers of two selected objects:  
 
dist(cen,cen)/2  
 
The following example finds the distance between the point (3,2,4) and a plane you define by 
selecting 3 endpoints: 
 
dpp([3,2,4],end, end, end)  
 
Obtaining a Radius (CAL) 
 
The rad function determines the radius of a selected object. 
 
rad Determines the radius of a selected object. The object can be a circle, an arc, or a 2D 
polyline arc segment. 
The following example uses rad with the CIRCLE command. The radius of the new circle is 
two-thirds of the radius of the selected polyline arc segment:  
 
Command: circle 3P / 2P / TTR / <Center point>: cen 
of Select the circle 
Diameter / <Radius>: 'cal  
>> Expression: 2/3*rad  
>> Select circle, arc or polyline segment for RAD function: Select the circle 
 
'DIST. 
The command  Dist Measures the distance and angle between two points 
 
At the Command prompt, enter dist 
First point: Specify a point  
Second point: Specify a second point  
Distance = calculated distance 
Angle in XY plane = angle  Angle from XY plane = angle 
Delta X = change in X, Delta Y = change in Y, Delta Z = change in Z 
 
AutoCAD reports the true 3D distance between points. The angle in the XY plane is relative to 
the current X axis. The angle from the XY plane is relative to the current XY plane. DIST 
assumes the current elevation value for the first or second point if the Z coordinate is omitted. 
The distance is displayed using the current units format. 
 
AREA 
This Command Area Calculates the area and perimeter of objects or of defined areas 
 
At the Command prompt, enter area 
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<First point> / Object / Add / Subtract: Specify a point or enter an option 
Using text 
Single line text 
This Command  Text Creates a single line of text 
AutoCAD can create text with a variety of character patterns, or fonts. These fonts can be 
stretched, compressed, obliqued, mirrored, or aligned in a vertical column by applying a style to 
the font. Text can be rotated, justified, and made any size. 
 
To create Single line text 
At the Command prompt, enter text 
Justify / Style / <Start point>: Specify a point or enter an option  
If TEXT was the last command entered, pressing  at the Justify/Style/<Start point> prompt skips 
the prompts for height and rotation angle and immediately displays the Text prompt. The text is 
placed directly beneath the previous line of text.  
The prompts that appear are the same as those for the DTEXT command, except the TEXT 
command displays the Text prompt only once. For a description of each option.When you use 
the Insertion Object Snap mode, AutoCAD snaps to the point you specified at the Start point 
prompt. 
 
Multiple text 
It is also possible to create multiple text in the form of paragraphs.This Command 
MTEXTCreates paragraph text 
MTEXT creates paragraphs that fit within a nonprinting text boundary. You define the text 
boundary, which specifies the width and alignment of the paragraph. Each Mtext object is a 
single object, regardless of the number of lines it contains. The text boundary, although not 
plotted or printed, remains part of the object's framework. 
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To create multiple text 
At the Command prompt, enter mtext 
Attach / Rotation / Style / Height / Direction / <Insertion point>: Specify a point or enter an 
option 
If you enter -mtext at the Command prompt, MTEXT displays prompts on the command line.  
 
 
Spell checking 
'SPELL -- Check Spelling 
After you have worked you may need to check for spelling errors in your texts accompanying 
your drawings. The  SPELL command corrects the spelling of text objects created with the 
TEXT, DTEXT and MTEXT commands. 
The Check Spelling dialog box appears only if AutoCAD finds a dubious word in the specified 
text. 
 
To Checks spelling in a drawing 
At the Command prompt, enter spell 
Select objects: Use an object selection method 
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DIMENSIONING 
Dimensioning are important part of most autocad drawings. Dimensions indicate the 
measurements of the models you have created  and are used in the manufacturing process. 
Dimensioning is usually done once you have completed your drawing. Dimensions are blocks 
and they are also associative i.e there is a connection  between the object and the dimensions so 
thet should the objects size change the dimensions also change automatically. 
 
The parts of a dimension line are: 
♦ Extension lines 
♦ Dimension text 
♦ Dimension line  
♦ Arrow heads 
♦ Definition point 
 
 
 
 
Drawing Linear Dimensions 
Linear dimensions are used for dimensioning lines,straight segments of apolyline or astraight 
segment in a block. You can also draw a linear dimmension for arcs and circles. 
The command Dimlinear Creates linear dimensions 
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At the Command prompt, enter dimlinear 
First extension line origin or RETURN to select: Specify a point or press  for automatic 
extension lines 
 
Point Specification 
If you specify a point for the first extension line, AutoCAD prompts for the second extension 
line origin. 
Second extension line origin: Specify a second  point  
 
If you press  to select an object, AutoCAD automatically determines the origin points of the first 
and second extension lines. 
For polylines and other explodable objects, only the individual line and arc segments are 
dimensioned. You can't select objects in a nonuniformly scaled block reference.If you select a 
line or an arc, its endpoints are used as the origins of the extension lines.  
 
Drawing aligned Dimensions 
When you want to dimension a linear object that is not orthogonal use an aligned dimensioning 
which is always parallel to the object and measures the actual length of an object as opposed to 
the vertical and horrizontal distances that you dimension with linear dimensioning. 
The command DIMALIGNED Creates an aligned linear dimension. 
 
 
To create aligned dimensioning: 
At the Command prompt, enter dimaligned 
First extension line origin or RETURN to select: Specify a point for manual extension lines, or 
press enter  for automatic extension lines 
If you select a circle, the endpoints of its diameter are used as the origin points. When the point 
used to select the circle is close to the north or south quadrant point, AutoCAD draws a 
horizontal dimension. When the point used to select the circle is close to the east or west 
quadrant point, AutoCAD draws a vertical dimension. 
 
Dimension line location (Text / Angle / Horizontal / Vertical / Rotated): Specify a point (3) or 
enter an option 
 
If you specify a point, AutoCAD uses the point to locate the dimension line and determine the 
direction to draw the extension lines. After you specify the location, AutoCAD draws the 
dimension and DIMLINEAR ends. 
 
Drawing Baseline and aContinued Dimensions 
Often you want to creat a whole series of attached and connected dimensions 
Baselin dimensions are a series of lines that start from the same point.the first extension line is 
the same for all the dimensions. The second dimension includes the first and an additional 
distance. Continued dimensions are series of dimensions that are all attached. The first extension 
line of the second dimensions is the second extension line of the first dimensions. 
 
To draw a baseline dimensions or Continued dimensions, first create one linear angular, or 
ordinate dimensions in the regular  way. 
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This Command baseline  Continues a linear, angular, or ordinate dimension from the baseline of 
the previous or selected dimension 
 
DIMBASELINE draws a series of related dimensions measured from the same baseline. 
AutoCAD uses a baseline increment value to offset each new dimension line and to avoid 
overlaying the previous dimension line. Baseline dimensioning is also known as parallel 
dimensioning. 
 
To use baseline dimensioning  
At the Command prompt, enter dimbaseline 
Second extension line origin or RETURN to select: Specify a point, or press  enter to select a 
base dimension 
The prompts that follow depend on the type of dimension that was last created in the current 
session of AutoCAD: no prior dimension, linear, ordinate, or angular. 
 
The command DIMCONTINUE  Continues a linear, angular, or ordinate dimension from the 
second extension line of the previous or a selected dimension 
DIMCONTINUE draws a series of related dimensions, such as several shorter dimensions, that 
add up to the total measurement. Continued dimensioning is also known as chain 
dimensioning.Note: When you create linear continued dimensions, the first extension line is 
suppressed and the placement of text and arrowheads might include a leader line. From the 
Dimensioning toolbar, choose  
 
 
To use continued dimensioning. 
 
At the Command prompt, enter dimcontinue 
The prompts that follow depend on the type of dimension that was last created in the current 
session of AutoCAD: no prior dimension, linear, ordinate, or angular.If the previous dimension 
was a linear, angular, or ordinate dimension, AutoCAD uses the origin of that dimension's 
second extension line for the origin of the next dimension's first extension line. 
 
DIMDIAMETER 
 
This Command Dimdiameter Creates diameter dimensions for circles and arcs 
DIMDIAMETER draws different types of diameter dimensions depending on the size of the 
circle or arc, the options in the DDIM Format dialog box, and the position of the cursor.  
 
To dimension the diameter of the circle: 
At the Command prompt, enter dimdiameter 
Select arc or circle: Select an arc or a circle  
The position of the cursor determines the location of the dimension line. As you move the cursor, 
the dimension moves around or inside the circle or arc. For horizontal dimension text, if the 
angle of the diameter line is greater than 15 degrees from horizontal and is outside the circle or 
arc, AutoCAD draws a hook line, also called a landing or dogleg, one arrowhead long, next to 
the dimension text, as shown in the first two illustrations. 
 
Different types of diameter dimensions  
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AutoCAD measures the diameter and displays the text with an Æ symbol in front of it. The next 
prompt is Dimension line location (Text / Angle): Specify a point or enter an option If you 
specify a point, AutoCAD uses the point to locate the dimension line. After you specify the 
location, DIMDIAMETER ends. 
 
Center Marks and Center Lines 
You control center marks or lines with the options in the DDIM Geometry dialog box. AutoCAD 
doesn't draw a center mark or line when a dimension line is drawn inside the arc or circle. The 
value of center marks and lines is specified under Center in the DDIM Geometry dialog box. 
AutoCAD stores the value in the DIMCEN dimensioning system variable. 
 
DIMCENTER 
This command Creates the center mark or the center lines of circles and arcs 
At the Command prompt, enter dimcenter 
Select arc or circle: Use an object selection method 
You can choose between center marks and center lines and specify their size in the Geometry 
dialog box of the DDIM command. To do this at the Command prompt, use the DIMCEN 
dimensioning system variable. 
 
 
DIMEDIT 
 
Edits dimensions 
 
DIMEDIT affects dimension text and extension lines. The Home, New and Rotate options affect 
dimension text. The Oblique option affects extension lines. DIMEDIT can operate on one or 
more dimension objects at a time. 
 
 At the Command prompt, enter dimedit 
Dimension Edit (Home / New / Rotate / Oblique) <Home>: Enter an option or press enter 
 
LEADER 
Leader are lines pointing to objects. At the end of the leader you place any text that you want. 
Use leaders to label objects or provide explanatory text. 
A leader line is an object that can be composed of an arrowhead attached to splines or straight 
line segments. In some cases, a short horizontal line, called a hook line, dogleg, or landing, 
connects text and feature control frames to the leader line. You can use various dimensioning 
system variables to format the leader line, such as placing the text above the hook lline. . 
LEADER creates complex leader lines. DIMDIAMETER and DIMRADIUS create simple 
automatic leader lines for circles and arcs. The command Leader Creates a line that connects 
annotation to a feature 
 
To use leaders : 
At the Command prompt, enter leader 
From point: Specify a point or use an Object Snap mode to attach the leader line to an object 
To point: Specify a point 
AutoCAD draws a leader line segment to the point specified and continues to prompt for other 
points and options. 
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COMPLEX OBJECTS: 
Autocad offers a number  of complex objects that help you create accurate proffesional 
drawings. Polylines are single objects that can combine line segments and arcs. Splines are 
mathematically controled curves based on pointsyou specify. Hatches create a solid or parttened 
fill. Multilines are sets of parallel lines. Sketching is a way of creating free hand drawings. 
 
Polylines. 
. Polylines are single objects that can combine line segments and arcs they are unique in that they 
can allow you to make thick lines and arcs. 
 
PLINE 
This command Creates two-dimensional polylines 
 
At the Command prompt, enter pline 
From point: Specify a point. 
Current line-width is <current> 
Arc / Close / Halfwidth / Length / Undo / Width / <Endpoint of line>: Specify a  second point or 
enter an option 
 
Splines  
SPLINE 
This command Creates a quadratic or cubic spline (NURBS) curve 
 
SPLINE fits a smooth curve to a sequence of points within a specified tolerance. 
 
 
 
 
 
 
 
 
 
 
 
 
 
To use spline: 
At the Command prompt, enter spline 
Object / <Enter first point>: Specify a point or enter o 
Enter First Point 
Creates a spline using points you specify. 
Enter point: Specify a point 
Enter points until you have defined the spline curve. After you have entered two points, 
AutoCAD displays the following prompt: 
Close / Fit Tolerance / <Enter point>:Specify a point, enter an option, or press enter 
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Hatching an object. 
Hatch patterns are blocks and are associative. Autocad stores hatch pattern definitions in the 
AutoCad.pat file 
 
HATCH 
HATCH fills the specified hatch boundary with a nonassociative hatch. A nonassociative hatch is 
not updated when its boundaries are modified. A hatch boundary consists of an object or objects 
that completely enclose an area. If the boundary is made up of multiple objects, their endpoints 
must coincide for the hatch to be created properly. You can also define a polyline hatch 
boundary with the direct hatch option. Unless otherwise specified, HATCH combines the lines 
that make up the hatch into a block.  
 
 At the Command prompt, enter hatch 
Pattern (? or name / U,style) <current>: Enter a predefined pattern name, enter u 
, enter ?, or press  
 
SKETCH 
This command lets you Create a series of freehand line segments and drawings  
Drawing with the SKETCH command controls a screen-based pen with a pointing device. 
SKETCH is useful for entering map outlines, signatures, or other freehand drawings. Sketched 
lines are not added to the drawing until they are recorded. The standard button menu is disabled 
while SKETCH is in progress.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
At the Command prompt, enter sketch 
Record increment <current>: Specify a distance or press  
The record increment value defines the length of the line segments. The pointer must be moved a 
distance greater than the increment value to generate a line. 
AutoCAD captures sketching as a series of independent lines. Setting the SKPOLY system 
variable to a nonzero value produces a polyline for each contiguous sequence of sketched lines 
rather than multiple line objects. 
 
Sketch.    Pen  eXit  Quit  Record  Erase  Connect  . (period) Enter an option, or press a pointer 
button. 
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BLOCKS: 
A common drawing task is placing the same group of objects  several times in a drawing. An 
architect needs to place windows and doors many times in the layout plan of a house. An 
electrical engineer places electrical symbols  in a drawing over and over. A mechanical model 
may include many nuts ,bolts ,surface finish symbols etc. blocks are group of objects that you 
create ,save and name so that you can insert them in your drawing whenever you need them. A 
block is one object regardless of the number of individual objects used to create it.once an object 
is made a block its grouped automatically. Thus it can be ungrouped  by exploding it. 
 
BLOCK 
This command Creates a block definition from a set of objects 
At the Command prompt, enter block 
Block name ( or ? ): Enter a name or ? 
 
 
 

Setting up your page for plotting in autoCAD 2000 
 

AutoCAD 2000 allows you to set up many layouts for plotting the same drawing. This is more 
convenient for different drawing requirements. 
 
To create a layout, in the insert menu, choose layout 
Layout- 
� New layout 
� Layout from template 
� Layout wizard 
 
Chose new layout to create a new layout. 
Chose from template to use an already designed layout from AutoCAD. 
A layout wizard guides you through the processes of creating a page layout. 
 
After creating a layout, configure its setup. In the file menu chose page setup or right click the 
layout bar and choose page setup. 
The following dialog box comes up.  
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Paper size-choose the paper size you want. 
Plot scale-This shows the ratio of the drawing to the real object on the ground. 
Plot offset-Determines the beginning of the drawing from the paper margin. 
Plot area- chose layout, extends or display. 
 
You are now ready to plot. 
 
 

Plotting with autoCAD2000 
 

1. Before plotting you need to install a plotter on your computer.  
• In the file menu choose plotter manager. 
• Follow the plotter manager wizard to install a plotter on your computer. 
 
2. Use plot style manager to assign different styles to your drawing. Several plot styles have 

been designed. You can change the settings.  
• In file menu choose plot style manager.  
• Different plot styles come up.  
• Double click a style to view the pattern layout. 
• After making necessary corrections you are ready to plot. 
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3. In the file menu, choose plot.  
� A plot dialog box appears, allowing you to change the plot configuration. 
 

 
 
• In the plot style table, under plot device menu, choose the plot style you configured above. 

Choose edit to make any changes to the style. 
• Plot settings allow you change settings of your paper, scale, plot area (layout or chose your 

own extends). 
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